
Human Spirometry HS-1-1

Experiment HS-1: Breathing 
Parameters at Rest and After 
Exercise

Background

The amount of air that moves in or out of the lungs 

during any one breathing cycle is called the tidal volume. 

After normal inspiration, it is possible to breathe in 

additional air—this is called the inspiratory reserve 

volume. Similarly, after a normal expiration, it is possible 

to exhale additional air from the lungs—this is the 

expiratory reserve volume. Even if the expiratory reserve 

volume is fully expelled from the lungs, there is still a 

volume of air in the lungs, called the residual volume, 

that cannot be exhaled. The residual volume has low 

oxygen and high carbon dioxide concentrations. Upon 

inhalation, fresh air mixes with stale air from the residual 

volume to create air in the alveoli that still has oxygen 

and carbon dioxide concentrations that facilitate the 

diffusion of O2 into and CO2 out of the capillaries.

The respiration center in the medulla insures that 

gaseous exchange at the lung matches the requirements 

of the body. During times of increased demand, the tidal 

volume can be increased, using some of the reserve 

lung volumes to bring more fresh air into the body. In 

addition, the rate of breathing and the rate of air 

movement in and out of the lungs can be changed. In 

this lab you will measure these parameters in a subject 

at rest and immediately after exercise, when the body’s 

demands for oxygen have been elevated.

Equipment Required

PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

SP-304 Spirometer

FH-300 Spirometer flow head and plastic tubes

IWX/214 Setup

1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure T-1-1 in the Tutorial Chapter for the location of 

the USB port and the power socket on the IWX/214.

3 Check Figure T-1-2 in the Tutorial Chapter for a picture of 

the IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 

on the rear panel of the IWX/214. 

5 Plug the power supply for the IWX/214 into the electrical 

outlet. Insert the plug on the end of the power supply cable 

into the labeled socket on the rear of the IWX/214. Use the 

power switch to turn on the unit. Confirm that the red power 

light is on.

Start the Software

1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 

the Windows Start menu, move the cursor to All Programs 

and then to the listing for iWorx. Select LabScribe from the 

iWorx submenu. The LabScribe Main window will appear 

as the program opens.

1 On the Main window, pull down the Settings menu and 

select Load Group.

2 Locate the folder that contains the settings group, 

IPLMv4Standard.iwxgrp. Select this group and click Open.

3 Pull down the Settings menu again. Select the Breathing-

Rest-Exercise-LS2 settings file.

4 After a short time, LabScribe will appear on the computer 

screen as configured by the Breathing-Rest-Exercise-LS2 

settings.

5 For your information, the settings used to configure the 

LabScribe software and the IWX/214 unit for this exper-

iment are listed in Table HS-1-1 on page HS-1-1. These 

settings are programmed on the Preferences Dialog 

window which can be viewed by selecting Preferences 

from the Edit menu on the LabScribe Main window.

Spirometer Setup

1 Locate the SP-304 spirometer, the FH-300, and the airflow 

tubing in the iWorx kit (Figure HS-1-1 on page HS-1-2).

2 Firmly push the two air flow tubes onto the two outlets on 

the FH-300 flow head. 

3 Firmly push the other ends of the two air flow tubes onto the 

two outlets on the SP-304 spirometer unit.

4 Plug the DIN8 connector to the SP-304 spirometer into the 

Channel 4 input of the IWX/214 (Figure HS-1-2 on page HS-

1-2).

Table HS-1-1: Settings on the Channel  Window 

of the Preferences Dialog Used to Configure the 

iWorx Recording System for Experiment HS-1.

Parameter Units /Ti t le Sett ing
Mode/

Funct ion

Acquis i t ion Mode Chart

Start User

Stop User

Disp lay Time Sec 10

Speed Samples/Sec 200

Channel  A4 Air  F low S DIN8

Channel  C1 Lung Volumes S Vol.Human
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 Figure HS-1-1: The SP-304 spirometer, the FH-300 flowhead, and the airflow 

tubing.

 Figure HS-1-2: A SP-304 spirometer connected to an IWX/214 unit.

Before Starting

1 Please read the procedures for each exercise completely 

before beginning the experiment. You should have a good 

understanding of how to perform these exercises before 

making recordings.

2 The spirometer will monitor breathing from a subject. It is 

important that the subject is healthy and has no history of 

respiratory or cardiovascular problems.

3 On the flow head, the outlets connected to the airflow tubing 

should always be pointed up to avoid problems with 

condensation developing within the tubing.

4 To reduce turbulence within the flowhead, place a 

disposable cardboard mouthpiece, that contains a screen, 

over the opening of the flowhead.

5 Use a clip to prevent air from entering or leaving the nose 

as the subject is breathing. air that passes through the nose 

is not included in the volume measurements and causes 

errors in these values.

6 The settings file, Breathing-Rest-Exercise-LS2, programs 

LabScribe to record the breathing of the subject on the Air 

Flow channel. The computed function used on the Lung 

Volumes channel converts the data recorded on the Air 

Flow channel to lung volume measurements. 

7 Enter the calibration voltage of your SP-304 spirometer into 

the Spirometry computed function used on the Lung 

Volumes channel:

• Click on the words Vol.Human (Air Flow), that are next to 
the title of the Lung Volumes channel, to open the computed 
function pull-down menu. 

• Select Setup Function from this pull-down menu to open the 
Spirometer Calibration Dialog window. 

• Enter the calibration voltage, that is listed on the label of 
your SP-304 spirometer unit, into the equation that sets the 
calibration voltage equal to one liter of lung volume.

• Make sure the reset time is set to 60 sec, and the first 5 
seconds of the recording are used to zero the baseline of the 
Lung Volumes channel. Click OK.

8 Allow the SP-304 to warm up for 10 minutes before 

recording for the first time. 

Note: Do not hold the spirometer amplifier in your hand; the 

heat of your hand will alter the volumes recorded.

9 When spirometry data is recorded in the conventional 

manner, inhalation is always displayed as an upward 

deflection. To determine if the subject is breathing through 

the correct end of the flow head.

• Click on the Save to Disk button in the lower left corner of 
the Main window to switch the LabScribe software into 
Preview mode. When LabScribe is in Preview mode, there is 
a red X across the Save to Disk button. In Preview mode, the 
iWorx recording system works without recording data on the 
hard drive or any other storage media which allows a subject to 
become comfortable with breathing through a spirometer.

• Click on the Preview button. Have the subject inhale through 
the spirometer flowhead. Click on the AutoScale button at the 
upper margin of the Air Flow and Lung Volumes channels. If 
the flowhead is oriented properly, the traces on the Air Flow 
and Lung Volumes channels will go up during inhalation. If 
the traces on these channels go down during inhalation, have 
the subject breathe through the other end of the flowhead, or 
reverse the positions of the airflow tubes at the outlets of the 
flowhead.

Note: If the user clicks the Preview button and an error 

window appears the Main window indicating the iWorx 

hardware cannot be found, make sure the iWorx unit is turned 

on and connected to the USB port of the computer. Then, click 

on the OK button in the error window. Pull down the LabScribe 

Tools menu, select the Find Hardware function, and follow 

the directions on the Find Hardware dialogue window

10 Click on the Stop button. 

11 Before proceeding to the actual exercises, make sure the 

LabScribe software in set to Record mode. Click on the 

Save to Disk button, in the lower left corner of the Main 

window, to change LabScribe from Preview mode to 

Record mode. When LabScribe is in Record mode, there is 

a green arrow on the Save to Disk button.
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Exercise 1: Breathing While Resting

Aim: To measure breathing parameters in a healthy, 

resting subject.

Procedure

1 Instruct the subject to:

• Sit quietly and become accustomed to breathing through the 
spirometer flowhead.

• Breathe normally before any recordings are made. 

• Hold the flowhead so that its outlets are pointed up.

• Remove the flowhead from his or her mouth and hold it at the 
mouth level in a position that prevents a breath from moving 
through the flowhead.

Note: The LabScribe software will zero the Lung Volumes 

channel during the first five seconds of recording. No air should 

be moving through the flow head during this time. 

2 Type <Subject’s Name> Resting in the Mark box that is to 

the right of the Mark button. 

3 Click on the Record button. After waiting five seconds for 

the Lung Volumes channel to zero, have the subject place 

the flowhead in his or her mouth and begin breathing. Press 

the Enter key on the keyboard to mark the recording.

4 Click the AutoScale buttons of the Air Flow and Lung 

Volumes channels. Notice the slowly moving wave on the 

Lung Volumes channel. Record five breaths, which 

normally takes about forty-five seconds to record. Every 

sixty seconds into the recording, the baseline of the Lung 

Volumes channel automatically resets itself to zero, which 

has no impact on the data being recorded.

 Figure HS-1-3: Air flow and lung volumes of the normal and forced breathing 

of a subject at rest.

5 Type Forced in the Mark box. Press the Enter key on the 

keyboard as the subject inhales as deeply as possible. After 

reaching his or her maximum inhalation volume, the subject 

should exhale as quickly and as completely as possible.

6 After the forced exhalation is complete, the subject should 

continue to breathe normally through the spirometer for five 

breath cycles.

7 Click Stop to halt recording. Your data may look like Figure 

HS-1-3 on page HS-1-3.

8 Select Save As in the File menu, type a name for the file. 

Choose a destination on the computer in which to save the 

file, like your lab group folder). Designate the file type as 

*.iwxdata. Click on the Save button to save the data file. 

Data Analysis-Normal Breathing at Rest

1 Scroll through the recording and find the section of data 

recorded when the subject was breathing while resting.

2 Use the Display Time icons to adjust the Display Time of 

the Main window to show at least four complete breathing 

cycles on the Main window. Four adjacent breathing cycles 

can also be selected by:

• Placing the cursors on either side of a group of four complete 
breathing cycles; and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar to expand the four selected breathing cycles 
to the width of the Main window.

 Figure HS-1-4: The LabScribe toolbar. 

3 Click on the Analysis window icon in the toolbar (Figure 

HS-1-4 on page HS-1-3) or select Analysis from the 

Windows menu to transfer the data displayed in the Main 

window to the Analysis window (Figure HS-1-5 on page 

HS-1-4).

4 Look at the Function Table that is above the uppermost 

channel displayed in the Analysis window. The mathe-

matical functions, V2-V1, Max_dv/dt, Min_dv/dt, and T2-T1 

should appear in this table. Values for V2-V1, Max_dv/dt, 

Min_dv/dt, and T2-T1 on each channel are seen in the 

table across the top margin of each channel.

5 Minimize the height of the Air Flow channel by clicking on 

the arrow to the left of the channel’s title to open the 

channel menu. Select Minimize from this menu to reduce 

the height of the channel display.

6 Maximize the height of the trace on the Lung Volumes 

channel by clicking on the arrow to the left of the channel’s 

title to open the channel menu. Select Scale from the 

menu and AutoScale from the Scale submenu to increase 

the height of the data on that channel.

7 Once the cursors are placed in the correct positions for 

determining the volumes and rates of each breath cycle, the 

values of the parameters in the Function Table can be 

recorded in the on-line notebook of LabScribe by typing 

their names and values directly into the Journal.
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8 The functions in the channel pull-down menus of the 

Analysis window can also be used to enter the names and 

values of the parameters from the recording to the Journal. 

To use these functions:

• Place the cursors at the locations used to measure the 
volumes and rates of the breath cycle.

• Transfer the names of the mathematical functions used to 
determine the volumes and rates to the Journal using the Add 
Title to Journal function in the Lung Volumes Channel pull-
down menu.

• Transfer the values for the volumes and rates to the Journal 
using the Add Ch. Data to Journal function in the Lung 
Volumes Channel pull-down menu.

9 On the Lung Volumes channel, use the mouse to click on 

and drag the cursors to specific points on the recording to 

measure the following volumes: 

• Tidal Volume (TV), which is the volume of air inhaled or 
exhaled during a normal breathing cycle. To measure the tidal 
volume of the subject during breathing at rest, place one cursor 
in the trough prior to inhalation, and the second cursor on the 
peak of the cycle. The value for the V2-V1 function on the 
Lung Volumes channel is the tidal volume.(Figure HS-1-5 on 
page HS-1-4).

 Figure HS-1-5: Breathing pattern of a subject at rest, displayed on the Lung 

Volumes channel in the Analysis window. The cursors are positioned on the 

trough and the peak of the breath cycle to measure the tidal volume (TV) with 

V2-V1 function and the maximum inspiratory flow rate with the Max_dv/dt 

function.

• Maximum Inspiratory Flow Rate, which is the maximum 
rate of air movement during inhalation. To measure the 
maximum inspiratory flow rate of the subject during breathing 
at rest, leave the cursors in the same positions used to 
measure the tidal volume. The value for the Max_dv/dt 
function on the Lung Volumes channel is the maximum 
inspiratory flow rate of that breath cycle (Figure HS-1-5 on 
page HS-1-4).

• Maximum Expiratory Flow Rate, which is the maximum 
rate of air movement during exhalation. To measure the 
maximum expiratory flow rate of the subject during breathing at 
rest, place one cursor on the peak of the breath cycle, and the 
second cursor in the trough to the right of that peak. The value 
for the Min_dv/dt function on the Lung Volumes channel is 
the maximum expiratory flow rate of that breath cycle (Figure 
HS-1-6 on page HS-1-4).This function is used since the 
exhalation portion of the breath cycle has a negative slope.

 Figure HS-1-6: Breathing pattern of a subject at rest, displayed on the Lung 

Volumes channel in the Analysis window. The cursors are positioned on the 

peak of the breath cycle and the trough of the succeeding cycle to measure the 

maximum expiratory flow rate with the Min_dv/dt function.

• Breath Period, which is the duration of each breathing cycle. 
To measure the breath period of the subject during breathing at 
rest, place one cursor on a peak of a breath cycle, and the 
second cursor on the peak of an adjacent cycle. The value for 
T2-T1 on the Lung Volumes channel is the period of that 
breath cycle (Figure HS-1-7 on page HS-1-4).

 Figure HS-1-7: Normal breathing pattern of a subject at rest, displayed on 

the Lung Volumes channel in the Analysis window. The cursors are 

positioned on the peaks of successive breath cycles to measure the breath 

period with the T2-T1 function.

10 Record the values in the Journal using the one of the 

techniques described in Steps 7 or 8.

11 Repeat the measurements of tidal volume, maximum 

inspiratory flow rate, maximum expiratory flow rate, and 

breath period on two additional normal breath cycles.

12 Average the three values obtained for each parameter and 

enter the means in a table in the Journal. You can open 

and close the Journal by clicking on its icon on the 

LabScribe toolbar (Figure HS-1-4 on page HS-1-3).

13 Record the means for the tidal volume, rates, and breath 

period in Table HS-1-3 on page HS-1-7.
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14 Calculate the normal breathing rate of the subject at rest 

using the following equation:

Breath Rate (breaths/minute) = 60 seconds/minute
mean breath period (sec/breath)

15 Multiply the mean tidal volume by the breathing rate to 

calculate the volume of air passing in and out of the resting 

subject’s lungs each minute.

16 Record the values for these calculations in Table HS-1-3 on 

page HS-1-7.

Data Analysis-Forced Expiration at Rest

1 Use the slider or the arrows on the scroll bar, at the bottom 

of the Analysis window, to position data recorded when the 

subject exhaled with maximum force in the window.

2 Use the Display Time icons to adjust the Display Time of 

the Analysis window to show the forced expiration curve 

and the two normal breaths, that occur before the force 

expiration curve, on the same window. These breathing 

cycles can also be selected by:

• Placing the cursors on either side of the group of appropriate 
breathing cycles; and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar to expand the selected breathing cycles to 
the width of the Main window.The segment of the recording 
displayed in the window should be like the recording in Figure 
HS-1-8 on page HS-1-5.

3 Use the same techniques used earlier to record volumes 

and rates in the Journal by:

• Typing the names and values of the parameters directly into 
the Journal, or;

• Transferring the names and values of the parameters into the 
Journal by using the Add Title to Journal and the Add Ch. 
Data to Journal functions in the Lung Volumes Channel 
menu.

4 Place the cursors on the forced expiration data displayed on 

the Lung Volumes channel to measure the following 

volumes and rates using the V2-V1, T2-T1, Max_dv/dt, and 

Min_dv/dt functions. Check the labels on Figure HS-1-8 on 

page HS-1-5 to identify the volumes and rates that you will 

measure:

• Tidal Volume (TV), by placing one cursor in the trough 
before the inhalation segment of the resting breath and the 
second cursor on the peak of that resting breath cycle. The 
value for the V2-V1 function on the Volume channel is the 
tidal volume.

• Inspiratory Reserve Volume (IRV), by placing one cursor 
on the peak of the normal breath prior to the maximum 
inhalation and the second cursor on the peak of the forced 
breath cycle. The value for the V2-V1 function on the Lung 
Volumes channel is the inspiratory reserve volume.

• Forced Inspiratory Flow Rate, by keeping the cursors in 
the same positions used for measuring IRV. The value for the 
Max_dv/dt function on the Lung Volumes channel is the 
forced inspiratory flow rate.

• Forced Vital Capacity (FVC), by placing one cursor on the 
peak of the forced breath cycle and the second cursor on the 
flat line after the subject has expelled all the air from his or her 
lungs. The value for the V2-V1 function on the Lung Volumes 
channel is the forced vital capacity.

• Forced Expiratory Flow Rate, by keeping the cursors in the 
same positions used for measuring VC.The value for the 
Min_dv/dt function on the Lung Volumes channel is the 
forced expiratory flow rate.

• Expiratory Reserve Volume (ERV), by placing one cursor in 
the trough before maximal inhalation and the second cursor on 
the flat line after subject has expelled all the air from his or her 
lungs. The value for the V2-V1 function on the Lung Volumes 
channel is the expiratory reserve volume.

• Forced Expiratory Volume at 1 Second (FEV1), by placing 
one cursor on the peak of the maximum breath cycle and the 
second cursor on the data point that is one second after the 
peak. Use the T2-T1 function to determine the data point that is 
one second after the peak. The value for the V2-V1 function on 
the Lung Volumes channel is the forced expiratory volume at 
one second.

• Forced Expiratory Volume at 3 Seconds (FEV3), by 
placing one cursor on the peak of the maximum breath cycle 
and the second cursor on the data point that is three seconds 
after the peak. Use the T2-T1 function to determine the data 
point that is three seconds after the peak. The value for the V2-
V1 function on the Lung Volumes channel is the forced 
expiratory volume at three seconds.

 Figure HS-1-8: Recording of normal and forced lung volumes taken from a 

subject at rest, and displayed on the Lung Volumes channel in the Analysis 

window. The normal breathing cycles are to the left of the forced inspiration 

and expiration. Lines and labels were added to figure to indicate to volumes 

that should be measured for each subject: Tidal Volume (TV), Inspiratory 

Reserve Volume (IRV), Expiratory Reserve Volume (ERV), Vital Capacity 

(VC), and Forced Expiratory Volume at 1 Second (FEV1).

5 Record these volumes and rates in Table HS-1-4 on page 

HS-1-7.

6 Calculate the subject’s FEV1/FVC ratio by dividing the 

subject’s FEV1 value by his or her FVC value.

7 Calculate the subject’s FEV3/FVC ratio by dividing the 

subject’s FEV3 value by his or her FVC value.
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8 Compare the FEV1/FVC and FEV3/FVC ratios of the subject 

to the normal values of 0.80 and 0.95, respectively, for 

young healthy adults. Both of these ratios decrease with 

age.

• In obstructive airway diseases, like asthma, bronchitis, or 
emphysema, both FVC and FEV1 are reduced, and FEV1/FVC 
ratios are usually less than 0.70.

• In restrictive lung diseases, like fibrosis, FVC is reduced. But, 
because of the low compliance and high recoil of the lungs, the 
FEV1/FVC ratio may be normal (~0.80) or greater than normal 
(>0.85).

9 Record the FEV1/FVC and FEV3/FVC ratios in Table HS-1-4 

on page HS-1-7.

10 Record the volumes, rates, and ratios from your subject in 

the table being compiled for all the subjects in the class.

Exercise 2: Breathing Immediately After 
Exercise

Aim: To measure the breathing parameters of the same 

healthy subject after exercise.

Procedure

1 In this exercise, use the same healthy subject whose 

breathing parameters at rest were measured in Exercise 1. 

2 Type After Exercise in the Mark box to the right of the 

Mark button. 

3 The subject should exercise to sufficiently elevate breathing 

rate, but with minimal class disruption. Running up and 

down flights of stairs is a good method. The subject should 

sit down after the exercise period. 

4 Click on the Record button. After waiting five seconds for 

the Lung Volumes channel to zero, have the subject place 

the flowhead in his or her mouth and begin breathing. Press 

the Enter key on the keyboard to mark the recording.

5 Click the AutoScale buttons of the Air Flow and Lung 

Volumes channels. Record at least five breaths as the 

subject is recovering from exercise. Remember the baseline 

of the Lung Volumes channel automatically resets every 

sixty seconds.

6 Type Forced in the Mark box. Press the Enter key on the 

keyboard as the subject inhales as deeply as possible. After 

reaching his or her maximum inhalation volume, the subject 

should exhale as quickly and as completely as possible.

7 The subject should return to breathing as normally as 

possible through the spirometer.

8 Click Stop to halt recording.

9 Select Save As in the File menu, type a name for the file. 

Choose a destination on the computer in which to save the 

file, like your lab group folder). Designate the file type as 

*.iwxdata. Click on the Save button to save the data file. 

Data Analysis

1 Perform the same types of measurements on the data 

recorded in Exercise 1. Record the measurements in the 

Journal. Report the appropriate measurements in 

Table HS-1-3 on page HS-1-7 and Table HS-1-4 on page 

HS-1-7

2 Determine the values for the calculated parameters taken 

from the recordings of normal and forced breathing after 

exercise. Report these values on Table HS-1-3 on page HS-

1-7 and Table HS-1-4 on page HS-1-7.

Exercise 3: Breathing Parameters from Other 
Students

Aim: To measure breathing parameters in other 

students in your lab group. Obtain data from subjects in 

other lab groups

Procedure

1 Attach a clean flowhead and clean air flow tubing to the 

spirometer for each new subject in your group doing this 

exercise.

2 Open a new data file for the new subject by selecting New 

on the File menu of the LabScribe program. The Save File 

dialogue window will appear on the screen if the current 

data file displayed on the LabScribe window if that file has 

not been saved recently. Click Yes to save the current file. 

The Choose a file dialogue window will appear on the 

screen. Select the folder where you would like the data file 

to be saved. Enter a name for the file and select the 

*.iwxdata as the type of file being saved. Click the Save 

button in the lower right corner of the dialogue window.

3 Repeat Exercise 1 with the new subject. 

Data Analysis

1 Perform the same types of measurements on the data 

recorded in Exercise 2. 

2 Record the measurements in the Journal. Report the 

appropriate measurements in Table HS-1-3 on page HS-1-7 

and Table HS-1-4 on page HS-1-7

3 Determine the values for the calculated parameters taken 

from the recordings of normal and forced breathing. Report 

the values for each subject on copies of Table HS-1-3 on 

page HS-1-7, Table HS-1-4 on page HS-1-7, and on the 

table being compiled for all subjects in the class.

Table HS-1-2: Lung Volumes for an Average- 

Sized Human Male (70kg).

Volumes Volume (mls)

Tidal  Volume (TV) 500

Insp ira tory Reserve Volume ( IRV) 3100

Expi ratory Reserve Volume (ERV) 1200

Forced Vital  Capacity  (FVC) 4800

Residual Volume (RV) 1200
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Questions

1 Are the lung volumes the same in all students?

2 Combine class data to see whether there is any correlation 

between tidal volume or vital capacity and gender, smoking, 

or apparent fitness.

Questions

Use your Anatomy and Physiology textbook to help 

determine the correct answers to the following questions.

1 Did tidal volume change after exercise? Did inspiratory and 

expiratory reserves change after exercise?

2 Did exercise influence the time taken for each breathing 

cycle?

3 Did the rate of air flow during the inhalation phase increase 

or decrease with exercise?   How can you account for the 

change?

4 Did the rate of air flow during the exhalation phase increase 

or decrease with exercise—how can you account for the 

change?

5 Did the volume of air passing in and out of the resting 

subject’s lungs each minute increase or decrease due to 

exercise? If so, was the change due to an increase in the 

rate of breathing, the depth of breathing (tidal volume), or a 

combination of both factors?

6 Did exercise influence the vital capacity of the individual?

7 If the tidal volume changed due to exercise, can this be 

accounted for by changes in the IRV, the ERV, or a combi-

nation of both?

8 Compare your data to what is supposed to happen physio-

logically. How do expected results compare to the observed 

results? Did you see what is expected?

Table HS-1-3: Mean Breathing Volumes and 

Rates from a Healthy Subject at Rest and after 

Exercise

Rest ing
After  

Exercise

Mean Breath Per iod (sec/breath)

Breath ing Rate (breaths/min)

Mean Tida l  Volume (mls/breath)

Minute Air  F low Rate ( l i te rs /min)

Max. Normal Air  F low Rate (mls/sec)

during inhalation 

during exhalation

Table HS-1-4: Forced Expirat ion Volumes and 

Rates from a Healthy Subject at Rest and after 

Exercise

Rest ing
After  

Exercise

Lung Volumes ( l i te rs)

Tidal Volume (TV)

Inspiratory Reserve Volume (IRV)

Expiratory Reserve Volume (ERV)

Vital Capacity (VC)

Forced Expiratory Volume-1sec (FEV1)

Forced Ai r Flow Rate (mls/sec)

dur ing inhala t ion 

dur ing exhala t ion

FEV1 /VC Rat io

FEV3 /VC Rat io
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